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1 Preface 

This manual is a User's Guide for Optimal Trace™ Server. Optimal Trace™ Server is the 
repository server for use with Optimal Trace™ Enterprise. Optimal Trace™ Server currently 
supports MySQL, Oracle, and Microsoft SQL Server databases. This manual provides a 
description of how to install and configure Optimal Trace™ Server, along with a detailed 
description of how to configure MySQL, Oracle, and Microsoft SQL Server. 

 

1.1 Audience 

This document is suitable for Database Administrators (DBA) who are responsible for the 
installation and upkeep of Optimal Trace™ Server in the organization. 

 

1.2 Contacting Optimal Trace™ Customer Support 

For all technical problems and support queries, please logon to frontline at 
http://frontline.compuware.com/products/ci/ Frontline contains the Optimal Trace™ forum as well as 
a FAQ area. Additionally, full up to date release information is provided. 

 

Compuware telephone customer support can be contacted in the U.S. on 1-800-538-7822. 
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2 Introduction to Optimal Trace™ Server 

Optimal Trace™ Server provides access to a centralized repository of Optimal Trace™ projects 
and manages communication between multiple Optimal Trace™ Enterprise users. A computer 
that hosts the Optimal Trace™ Server software is referred to as a Repository Server.  
 
Optimal Trace™ Server controls access to the database, manages concurrent editing of 
projects by multiple users and ensures the integrity of data being written to the database. If 
you wish to make use of the collaboration features in Optimal Trace™, you will need at least 
one Repository Server on your network. 
 
Optimal Trace™ Server requires a dedicated server machine on your network to act as the 
Optimal Trace™ Server repository server. This machine should be connected to the network in 
such a way as to be accessible from every workstation on which you will be running Optimal 
Trace™. Optimal Trace™ Server connects to a database (Oracle 9i, MS SQL Server or MySQL) 
running locally on the Repository Server or on another machine available on the network. 
 

2.1 System Requirements for Optimal Trace™ Server 

  
-          Pentium 3-class processor or equivalent 
-          512 MB of RAM (minimum) 
-          250 MB of available hard disk space 
-          Microsoft Windows 2000, Windows XP, Windows 2003, Windows 2000 Server or   
 Windows 2003 Server 
-          Adobe Acrobat Reader for Optimal Trace™ Server Help Files 
-          MySQL Version 4.1 or 5.0, Oracle 9i (R 1/2) or 10g (R2), Microsoft SQL Server 2000 
(SP3), Microsoft SQL Server 2005 

 

Note: MySQL 5.0 supported versions:   

Development and test was on version 5.0.37 due to known issues with 5.0.42 which should 
be resolved for future MySQL releases. 

 
Optimal Trace™ Server has not been tested to run on Windows 95, and is not supported on 
this platform.  
Optimal Trace™ Server has not been tested to run on Windows NT 4.0, and is not supported 
on this platform. 
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3 Upgrading from Optimal Trace™ Server 4.1 to Optimal Trace™ Server 5.0 

Please skip this section if you do not have an existing installation of Optimal Trace™ Server 
4.1 (vanilla or with service packs). 

Optimal Trace™ Server 5.0 uses a different database structure from version 4.1. Your project 
data will be migrated automatically. 

As always, we strongly recommend backing up your 4.1 database as a precautionary 
measure. 

The following instructions will help you through the full upgrade procedure from 4.1 to 5.0. 
Note that you should not remove 4.1 before installing 5.0. Only perform that step after your 
5.0 server is up and running. 

 

3.1 Backup your 4.1 data 

It is vital that you backup your data before upgrading from 4.1 to 5.0. 
 
Essentially, this means that you should backup your database. And it is also good practice to 
take your important Projects 'offline' in Enterprise 4.1 and save them locally on your hard 
disk. It is important to backup your old data as it can take many hours to migrate your old 
Optimal Trace™ data, which could be interrupted by machine or network errors during this 
time which will leave your data in a half migrated state. 

 

3.1.1 Backing up your MySQL Database 

To backup your MySQL database: 

- from a 'cmd' prompt, change directory to c:\mysql\bin (or wherever MySQL is installed) 

- type 'mysqldump -q catalyze3 > c:\temp\OptimalTrace-data-backup.sql'. 

Note: You may need user/password included in the command line for this. 

 

 

This will create a backup file called 'OptimalTrace-data-backup.sql' in your c:\temp\ directory. 
You may want to move this somewhere for safer keeping. 

6  Optimal Trace™ Server 5.0 Users Guide 
 

 



 
 

 
 

3.1.2 Backing up your Oracle 9i Database 

Creating a backup of your Catalyze3 tablespace in Oracle is beyond the scope of this 
document. Please contact your Oracle DBA. 

Note: to avoid a potential problem with Oracle's 'OPEN_CURSORS' setting that you may 
encounter when migrating, it is best to set this Oracle setting now. To do this, change the 
value of OPEN_CURSORS to 20000 in the following files 

  - init.ora in <oracle_install_dir>\admin\OEMREP\pfile 

  - init.ora in <oracle_install_dir>\admin\Oracle\pfile 

  - init.ora in <oracle_install_dir>\admin\prod\pfile 

And then reboot the machine. For more information on this Oracle issue, see: 
http://www.praetoriate.com/oracle_tips_mamt_parameter_file.htm. 

 

3.1.3 Backing up your MS SQL Server 2000/2005 Database 

To backup your MS SQL Server database: 

- Launch 'Enterprise Manager' from the 'Microsoft SQL Server' Start menu 

- Navigate to the 'catalyze3' database: 

 

- Select the 'Tools\Backup Database' menu option 
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- Modify the configuration as you see fit and then hit 'OK':  

 

 

 

3.1.4 Taking Projects 'offline' in Optimal Trace™ Enterprise 

To take your important projects offline in Optimal Trace, do the following: 

- launch the older version of 'Optimal Trace Enterprise' from the Start menu. 

- Open the remote Projects that you want to take offline 

- Select the 'Project\Download Repository Project to Local Project' menu option (or 
hit the ' ' button from the toolbar). 

- Enter a filename for the Project and hit save. 

 

3.2 Stop the 4.1 Server 

First stop the 'Optimal Trace Enterprise' 4.1 server. If the server is running from the GUI, 
simply hit the stop button. If your 4.1 server is running as a windows service, stop it as 
follows: 

- open Control Panel and launch 'Administrative Tools' -> 'Services' 
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- navigate to 'Catalyze Enterprise Server 4.1': 

 

 

- right click, and select 'Properties': 

 

 

- 'Stop' the service (if its running) 
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- Change the 'Startup type' to 'Manual' 

 

3.3 Install Optimal Trace™ Server 5.0 

Install the Optimal Trace™ Server 5.0: 

- double click on 'Optimal_Trace_Server_Install.exe' to start the installation process. 

- follow the instructions by clicking the 'next' button.  

- finally click 'Finish' to install. The install should complete in a matter of minutes. 

- Once the installation is complete, launch 'Optimal Trace Server 5.0' from 
'Programs/Compuware/Optimal Trace Server 5.0' on the Start menu 

 

3.4 Run Optimal Trace™ Server 5.0 

It's time to start our Server and migrate the data. Hit the start button: 

 

 

 

 You will get a message asking you to confirm that you want to migrate your data: 
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Note: It can take several hours to migrate your data from 4.1 to 5.0 format, depending on 
how big your database is. It may be best to perform this operation overnight.  

 

 
 
To back up MySQL please see section 3.1.1 Backing up your MySQL Database, to back up 
Oracle see section 3.1.2 Backing up your Oracle 9i Database and for MS SQL Server see 
section 3.1.3 Backing up your MS SQL Server 2000/2005 Database. To take projects offline 
see section 3.1.4 Taking Projects 'offline' in Optimal Trace™ Enterprise. 
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4 Upgrading from SteelTrace Server 4.0 to Optimal Trace™ Server 5.0 

Please skip this section if you do not have an existing installation of SteelTrace Server 4.0 
(vanilla or with service packs). 

Please note that the 'SteelTrace' name was dropped for the 4.1 release, i.e. the 4.0 product 
'SteelTrace Server' was rebranded to 'Optimal Trace™ Server'. 

Optimal Trace™ Server 5.0 uses a different  database structure to SteelTrace Server 4.0 for 
its project data. Another difference in 5.0 is that the access control data is now also stored in 
the database. 

As always, we strongly recommend backing up your 4.0 database as a precautionary 
measure. 

The following instructions will help you through the full upgrade procedure from 4.0 to 5.0. 
Note that you should not remove 4.0 before installing 5.0. Only perform this step after your 
5.0 server is up and running. 

 

4.1 Backup your 4.0 data 

We highly recommend that you backup your data before upgrading from 4.0 to 5.0. 
 
Essentially, this means that you should backup your database and it is also good practice to 
take your important Projects 'offline' in Enterprise 4.0 and save them locally on your hard 
disk. 
 
To back up MySQL please see section 3.1.1 Backing up your MySQL Database, to back up 
Oracle see section 3.1.2 Backing up your Oracle 9i Database and for MS SQL Server see 
section 3.1.3 Backing up your MS SQL Server 2000/2005 Database. To take projects offline 
see section 3.1.4 Taking Projects 'offline' in Optimal Trace™ Enterprise. 
 

4.2 Stop the 4.0 Server 

First stop the 'SteelTrace Enterprise' 4.0 server. If the server is running from the GUI, simply 
hit the stop button. If your 4.0 server is running as a windows service, stop it as follows: 

- open Control Panel and launch 'Administrative Tools' -> 'Services' 

- navigate to ' SteelTrace Server 4.0': 
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- right click, and select 'Properties': 

 

- 'Stop' the service (if its running) 
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- Change the 'Startup type' to 'Manual' 

 

4.3 Install Optimal Trace™ Server 5.0 

Install the Optimal Trace™ Server 5.0: 

 

- double click on 'Optimal_Trace_Server_Install.exe' to start the installation process: 

 

- follow the instructions by clicking the 'next' button. During the install you will be 
prompted to copy over permissions settings to 5.0. Click 'Yes' if you wish to do so 
(it is recommended that you do). 

 

 

- finally click 'Finish' to install. The install should complete in a matter of minutes. 

- Once the installation is complete, launch 'Optimal Trace™ Server 5.0' from 
'Programs/Compuware/Optimal Trace Server 5.0' on the Start menu 

- Enter the same configuration values in the new 5.0 server as you had specified in 
4.0 and hit 'Apply' 
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4.4 Run Optimal Trace™ Server 5.0 

It's time to start our Server. Hit the start button and the server should start after a short 
period of time. 

 

Note Access Control: In version 4.0, the Groups, Users and Permissions for access control 
were specified in files. These are now stored directly in the database. You do not need to 
manually migrate these and there is no manual step required. 

When you first hit start after the upgrade, the system will detect that this is the first time 
running the new server. As this is the first time running, the Access Control files are 
automatically converted and stored in the database. This initial start time takes slightly longer 
than a normal start. 

 

 

4.5 Run Optimal Trace™ Enterprise 5.0 

Once the migration is finished and your 5.0 Server has started successfully, you are now 
ready to use Optimal Trace™ Enterprise 5.0. 

See section 9.1 Starting Optimal Trace™ Server for full details on connecting from the 
Optimal Trace™ Enterprise client to the server. 
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5 Installing MySQL 

MySQL is a popular Open Source Database. Full details can be found at 
http://www.mysql.com.  

 

5.1 Obtaining MySQL 

MySQL v. 5.0 (and 4.1) are the versions of MySQL supported by Optimal Trace™ Server. The 
MySQL v. 5.0 software can be downloaded from the MySQL site. 

Note MySQL 5.0 supported versions:  Optimal Trace Enterprise 5.0 does not support 
MySQL 5.0.42 and recommend that people use 5.0.37. 

 

When you are finished downloading, you should have the MySQL installation file: mysql-
5.0.X-win.zip, where ‘X’ is the minor version number. (e.g. mysql-5.0.37-win32.zip) 

 

5.2 Installing MySQL 

The following steps are needed for a typical MySQL install: 

1. If you are running an earlier version of MySQL you must shut the service down before 
upgrading. This is done by typing  
>NET STOP mysql at a command prompt. 

2. Unzip mysql-5.0.37-win32.zip to e.g. C:\Mysql 
3. Run setup.exe from e.g. C:\Mysql 
4. When prompted to what sort of installation you would like, choose Typical. 
5. When finished installing you now need to set up MySQL as a Windows Service. To install 

MySQL on NT/Win2000 as a service: 
a. You must first create a file named my.cnf, which must reside in the root drive where 

the MySQL installation has been placed. For example if you installed to c:\mysql then 
the my.cnf file would be located at c:\my.cnf, if you installed to an e: drive then the 
cnf file would be located at: e:\my.cnf 

b. Place the following entries into the my.cnf file: 
Alternatively see the note below on using a copy of the sample MySQL configuration 
file shipped with Optimal Trace™ Server. 

 
# The MySQL server 
[mysqld] 
basedir=c:/mysql 
datadir=c:/mysql/data 
set-variable = max_allowed_packet=100M 
 
innodb_data_file_path = ib:200M:autoextend 
innodb_data_home_dir=c:/mysql/ibdata 
set-variable = innodb_mirrored_log_groups=1 
innodb_log_group_home_dir=c:/mysql/iblogs 
set-variable = innodb_log_files_in_group=3 
set-variable = innodb_log_file_size=30M 
set-variable = innodb_log_buffer_size=8M 
innodb_flush_log_at_trx_commit=1 
innodb_log_arch_dir=c:/mysql/iblogs 
innodb_log_archive=0 
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set-variable=innodb_buffer_pool_size=80M 
set-variable=innodb_additional_mem_pool_size=10M 
set-variable=innodb_file_io_threads=4 
set-variable=innodb_lock_wait_timeout=50 

 
Note: Optimal Trace™ Server ships a sample MySQL configuration file, called ‘my.cnf.txt’, 
which can be found after you install Optimal Trace™ Server, in the Scripts folder in your 
Optimal Trace™ Server installation folder. You can copy this file to the root drive (e.g. ‘c:’) 
and rename it to ‘my.cnf’ (i.e. remove the ‘.txt’ extension string).  
 
To edit a file’s extension string (e.g. ‘.txt’) using Windows Explorer: 

• move through Tools/Folder Options/View 
• remove the tick from the check box labeled ‘Hide file extensions for known file 

types’ 
• rename the file to remove ‘.txt’ from the file name. 

 
For the file name example above, i.e. ‘my.cnf.txt’, Windows may then hide the string ‘.cnf’ 
and the file name may appear simply as ‘my’.  
 
For information on Installing Optimal Trace™ Server see Section 8. 
 
MySQL also ships with a sample .cnf file called: 'my-example.cnf'. This file contains many 
other additional parameters that can be configured for MySQL. See 
http://www.mysql.com/documentation/index.html if you want to understand these 
settings. If you have any problems, you can mail to win32@lists.mysql.com. The MySQL 
mailing list archive is at: http://www.mysql.com/documentation/index.html 

 
6. If the installed version of MySQL requires transactional tables to be manually enabled then  

you must create two sub-directories in the MySQL install directory. Name the newly 
created directories ‘ibdata’ and ‘iblogs’. Your Mysql directory structure should now look 
something like the following: 
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MySQL install directory structure 

 
7. To complete the procedure for installing MySQL as a service on Windows 2000 use a 

command window by moving through Start/Programs/Accessories/Command Prompt or 
invoke cmd.exe, Windows 98 users please invoke command.exe, and change the directory 
to your MySQL installation folder (e.g. c:\mysql\bin) and run: 

 
mysqld-max-nt --install    
 
‘--install’ means mysqld-max-nt expects a parameter 

   
Upon successful installation ‘Service successfully installed’ will appear on the screen. 
 
Note: 'mysqld-max' is used because it provides support for symbolic links, BDB tables and 
InnoDB tables. This allows the use of transactional tables, which are used by Optimal 
Trace™ Server. 
 

8. Now that MySQL is installed as a service it can be started and stopped, from anywhere on 
the command screen, using the NET command as follows: 

 
NET START mysql 

 
Upon a successful start ‘The MySQL service was started successfully’ will appear on the 
screen. 

 
NET STOP mysql 
 

MySQL may take 5 minutes to stop. Upon a successful stopping ‘The MySQL service was 
stopped successfully’ will appear on the screen. 

 
MySQL can also be started from the Services directory by moving through 
Start/Settings/Control Panel/Administrative Tools/Services/MySQL. 
 

9. Now start mysql: 
 

NET START mysql    
Upon a successful start ‘The MySQL service was started successfully’ will appear on the 
screen. 
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10. You now need to create the Optimal Trace™ Database and Server tables. To do this you 

will need to copy and run some scripts.  
First move to location where you have installed Optimal Trace™ Server and copy 
‘mysql_OptimalTrace_install.sql’ from the  
'<ENTERPRISE_SERVER_INSTALL_DIR>\scripts' directory into your MySQL install 
directory\scripts 
 

11. Next you will create the database tables and a user.  
a. Type the following line to create the database tables: 

 
C:\MySql\bin>mysql -uroot < ..\scripts\mysql_Optimal Trace_install.sql 

 
Upon successful completion there will be no response, only the prompt C:\Mysql\bin. 
 
Note, by default the root user has no password so the above command should work 
without modification. If the root users password has been modified then you will get the 
following error message: 
 
ERROR 1044 at line 1: Access denied for user: '@localhost' to database 'catalyze3' 
 
If this is the case, an additional password argument must be supplied after the user name, 
e.g. 
 
 C:\Mysql\bin>mysql -uroot -ppassword < ..\scripts\mysql_Optimal 
Trace_install.sql 
 
 
You now have a user with SELECT, INSERT, UPDATE and DELETE privileges on the 
'catalyze3' database with username ‘catalyze3’ and password ‘password’. 
 
Now that you have set up your Optimal Trace™ Server database, it is time to start the 
Optimal Trace™ Server application. For a complete description of how to start Optimal 
Trace™ Server, see Section 9 Running Optimal Trace™ Server. 

 

5.2.1 Uninstalling MySQL 

If you are using MySQL and wish to uninstall it, move through Start/Settings/Control 
Panel/Add/Remove Programs and click on the version of MySQL that you want to remove, i.e. 
uninstall. Click on the Change/Remove button and an Install Anywhere Uninstaller screen will 
appear. Click on the Uninstall button if you are sure you want to remove the version of 
MySQL. This will completely remove all components installed by you using InstallAnywhere. It 
will not remove files and folders created after the installation. 

 

Note: Do not attempt to uninstall MySQL by discretely deleting files/folders as this could 
create problems for you later.  
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6 Configuring Oracle    

This section details the steps involved in configuring Optimal Trace™ Server with Oracle.  

Oracle 9i and 10g are the versions of Oracle supported by Optimal Trace™ Server. 

 

Note: This section is targeted at Oracle database administrators with Windows 2000/NT 
administration knowledge. 

 

6.1 Prerequisites 

The Oracle software is installed. This includes setting up various environment variables unique 
to your operating system and establishing the directory structure for software and database 
files.  

You need to have the operating system privileges associated with a fully operational database 
administrator. You must be specially authenticated by your operating system or through a 
password file, allowing you to start up and shut down an instance before the database is 
created or opened.  

Ensure that there is sufficient memory available to start the Oracle instance, and that there is 
sufficient disk storage space for the planned database on server.  

 

6.2 Setting up the Oracle database 

 
You can either setup a new Oracle database explicitly for Optimal Trace™, or reuse an 
existing database. Setting up an Oracle database is beyond the scope of this document, so to 
do so, refer to your Oracle sysadmin or to Oracle documentation. The rest of these 
instructions assume that you already have an Oracle database called 'Catalyze'. 
 
The scripts needed to create tablespaces, tables and user privileges are contained in the 
Optimal Trace™ Server install, in the ‘scripts directory’. You can copy the scripts from here to 
Oracles default location, this is ORACLE_HOME\database on Windows.  
 
The following steps need to be taken in order to set up the Optimal Trace™ database objects : 
 
Start SQL*Plus and connect to your Oracle instance AS SYSDBA: 
 

SQL> CONNECT SYS/password AS SYSDBA  
 
You already have a database set up, so you need to create a tablespace, tables, indexes, 
sequences and a user. From SQL*Plus command line type: 
 

SQL> @"ENTERPRISE_SERVER_INSTALL_DIR \scripts\ oracle_Optimal 
Trace_install.sql" 
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This script will create a table space for your Optimal Trace™ Server called ‘catalyze3’, as well 
as user ‘catalyze3’ with password ‘password’. You can change this username and password 
when the Optimal Trace™ Server database is fully set up. 
 
Now that you have set up your Optimal Trace™ Server database, it's time to start the Optimal 
Trace™ Server application. For a complete description of how to start Optimal Trace™ Server, 
see Section 9 Running Optimal Trace™ Server. 
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7 Configuring Microsoft™ SQL Server 

This section details the steps involved in configuring Optimal Trace™ Server with Microsoft™ 
SQL Server. 

Optimal Trace™ Server 5.0 can connect to both the 2000 and 2005 editions of Microsoft™ 
SQL Server. 

 

Note: This section is targeted at SQL Server database administrators with corresponding 
supporting Operating Systems administration knowledge. 

The SQL Server 2000 installation version used for all internal development and test was 
8.00.760 (SQL Server 2000 SP3) on a Windows 2000 Server platform. 

The SQL Server 2005 installation version used for all internal development and test was 
9.00.1399.00 on a Windows 2003 Server platform. 

 

 

 

7.1 Prerequisites 

Microsoft™ SQL Server software is installed. This installation is beyond the scope of this 
document, to do this please refer to all installation documentation provided with the 
Microsoft™ SQL Server installation media. 

- Major documentation/support/downloads etc. for SQL Server is available at 
www.microsoft.com/sql/ 

- Also when SQL Server is installed, it is packaged with a substantial documentation section 
available by clicking on Start Menu-> Programs->Microsoft SQL Server-> Books online. This 
documentation details all areas of usage for SQL Server. 

You need to have the privileges associated with a fully operational database administrator and 
be allowed to start up and shut down an instance of SQL Server before the database is 
created or opened. 

Ensure that there is sufficient memory available to start the SQL Server instance, and that 
there is sufficient disk storage space for the planned database on server.  

7.2 Setting up the SQL Server database 

 
The script needed to create the Optimal Trace™ database, tables and user privileges is 
contained in the Optimal Trace™ Server install, in the scripts directory.  
The following steps need to be taken in order to set up the Optimal Trace™ database objects. 
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- Microsoft™ SQL Server 2000 Edition 
 
The simplest way to create the Optimal Trace™ database is to use the 'Query Analyzer' 
tool supplied with the SQL Server installation.  
 
This can be run as follows 
- From the Start menu Programs->Microsoft SQL Server ->Query Analyzer 
- Running the isqlw utility from the command line 
 
For any required information on using the 'Query Analyzer' see  
'Using the SQL Server Tools-> UserInterface Reference-> SQL Query Analyzer Help' 
in the SQL Server Books Online documentation provided with the SQL Server installation. 
   
Start the 'Query Analyzer' tool and connect to the master database (default) with admin 
permissions (Windows or SQL Server authentication) 
 
From file menu select 'Open' 
Go to the Optimal Trace\Optimal Trace Server 5.0\scripts directory   
And open the file  mssqlserver_Optimal Trace_install.sql  
Once the file is opened you need to invoke the script using the Execute-Query (F5) 
command. This will invoke all queries within the script (create Database, Tables and 
User/Privileges) 
 
Invoking this script will create the database for Optimal Trace ™ ('catalyze3') and all the 
required tables, as well as user ‘catalyze3’ with password ‘password’.  
You can change this username and password when the Optimal Trace™ Server database is 
fully set up. 
 
You can now close the opened script file and exit the SQL Server Query Analyzer tool. 
 
 
- Microsoft™ SQL Server 2005 Edition 
 
The SQL Server Management Studio In Microsoft™ SQL Server 2005 Edition combines the 
functionality of the Enterprise and Query managers (used in the 2000 edition) into one 
easy to use graphical tool. 

Open the Management Studio via the  

Start menu Programs->Microsoft SQL Server 2005 - SQL Server Management Studio  

Using the File->Open-> file menu option go to the  

Optimal Trace\Optimal Trace Server 5.0\scripts directory   

And open the file  mssqlserver_OptimalTrace_install.sql  
 
And then select the 'Execute' option from the toolbar. 
This will invoke all queries within the script (create Database, Tables and User/Privileges) 
 
Invoking this script will create the database for Optimal Trace ™ ('catalyze3') and all the 
required tables, as well as user ‘catalyze3’ with password ‘password’.  
You can change this username and password when the Optimal Trace™ Server database is 
fully set up. 
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You can now close the opened script file and exit the Management Studio. 
 
Note: on some installations of Sql Server 2005 edition, security policy does not allow the 
creation of a database and user using the password 'password'. If this problem occurs, 
modify the mssqlserver_optimaltrace_install.sql to make the password more secure, and 
re-run the script. 

 
 
 

Now that you have set up your Optimal Trace™ Server database, it's time to start the Optimal 
Trace™ Server application. For a complete description of how to start Optimal Trace™ Server, 
see Section 9 Running Optimal Trace™ Server. 
 

7.3 Removing the Optimal Trace™ database 

 
If for any reason you need to remove the Optimal Trace™ database then the simplest way to 
do so is using either the SQL Server Query Analyzer or the SQL Server Enterprise Manager 
tools. 
Before attempting to delete please ensure that there are no active connections to the 
database. These can include a running Optimal Trace™ Server or open connections to the 
database within the Query Analyzer or the Enterprise Manager tools. 
 
Query Analyzer (2000 Edition) 
 
Select the 'catalyze3' database within the InstalledServer list (on the left hand side tree). 
Right click and select Delete (or just hit the delete key!) 
This will remove the database. 
 
Enterprise Manager (2000 Edition) 
 
On the left hand side tree navigate to  
Microsoft SQL Servers-> SQL Server Group-> InstalledServer-> Databases and select 
database 'catalyze3'. 
Right click and select Delete (or just hit the delete key) 
This will remove the database. 
Also the created user can be removed, to do this navigate to  
Microsoft SQL Servers-> SQL Server Group-> InstalledServer->Security->Logins 
And delete the user 'catalyze3'. 
 
The database can then be recreated by following the steps above. 
 
Management Studio (2005 Edition) 
 
On the left hand side tree navigate to  
Microsoft SQL Servers-> Databases and select database 'catalyze3'. 
Right click and select Delete (or just hit the delete key) 
This will remove the database. 
Also the created user can be removed, to do this navigate to  
Microsoft SQL ->Security->Logins 
And delete the user 'catalyze3'. 
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7.4 MS SQL Server Notes 

 

7.4.1 mssqlserver_Optimal Trace_install.sql 

A) The 'catalyze3' database is created with default settings (size, growth etc.) as follows 
 Create database catalyze3 
 
The following command can be used instead to create a database with specified sizes etc. 
Note that you must ensure that the data path is set correctly to Microsoft SQL Server data 
path (.mdf + _log file locations)) 
 
Create database [catalyze3]  ON (NAME = N'catalyze3', FILENAME = N'C:\Program 
Files\Microsoft SQL Server\MSSQL\data\catalyze3.mdf' , SIZE = 100, FILEGROWTH = 10%) 
LOG ON (NAME = N'catalyze3_log', FILENAME = N'C:\Program Files\Microsoft SQL 
Server\MSSQL\data\catalyze3_log.LDF' , SIZE = 30, FILEGROWTH = 10%) 
 
To use the second command then simply comment out the first and uncomment the second 
(both are given in the script with the second commented out.) 
The specified values given can be changed as required by the administrator. 
 
B) A login called 'catalyze3' is created and given a 'db_owner' role on the database. 
 
exec sp_addlogin 'catalyze3', 'password' ,'catalyze3' 
exec sp_grantdbaccess 'catalyze3' 
exec sp_addrolemember 'db_owner', 'catalyze3' 
 
This can be amended by administrator but read/write access to the database is required. 

 

7.4.2 SQL Server Enterprise Manager 

The Enterprise Manager has very useful functionality for viewing information (structure and 
values) for the database, the table structures and the login details.  
For all information regarding the Enterprise Manager see 
Using the SQL Server Tools-> UserInterface Reference-> SQL Server Enterprise Manager Help 
in the SQL Server Books Online documentation provided with the SQL Server installation. 

 

7.4.3 Other SQL Server utilities 

Some other useful utilities within Enterprise Manager are the 'Scripting Object..'  functionality 
of the Query Analyzer and the 'Generate SQL Script…', which can be used to see a formatted 
version of the install script containing default parameter values. 
Other useful utilities are items such as: 
- Database Maintenance plan Wizard (which runs integrity checks, updates statistics and 
performs backups) 
- Table viewing functionality (in spreadsheet format) 
- Profiler  
- Adding/Removing Logins GUI (in security) 
 
- And many others. 
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A detailed description of all of these is outside the scope of this document but is contained in 
the Books online section in the SQL Server Books Online documentation provided with the 
SQL Server installation. 
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8 Installing Optimal Trace™ Server 

This section describes how you may install and uninstall Optimal Trace™ Server. 

 

8.1 Installing Optimal Trace™ Server 

If you are upgrading from older versions 4.0 or prior please see the specific instructions 
earlier in this help document. 

Run/click on the Optimal_Trace_Server.exe file to install Optimal Trace™ Server: 

 

 

- follow the instructions by clicking the 'next' button. During the install you will be 
prompted to copy over permissions settings to 5.0. Click 'Yes' if you wish to do so 
(it is recommended that you do). 

- finally click 'Finish' to install. The install should complete in a matter of minutes. 

- Once the installation is complete, launch 'Optimal Trace Server 5.0' from 
'Compuware/Optimal Trace Server 5.0' on the Start menu 

 

8.1.1 Uninstalling Optimal Trace™ Server 

To uninstall Optimal Trace™ Server move through Start/Settings/Control Panel/Add/Remove 
Programs and click on the version of Optimal Trace™ Server that you want to uninstall. Click 
on the Change/Remove button and an Uninstall screen will appear. Click on the Uninstall 
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button if you are sure you want to remove the version of Optimal Trace™ Server. This will 
completely remove all components installed by you. Alternatively you can uninstall Optimal 
Trace™ Server via the start menu by going to Start/Programs/Compuware/Optimal Trace 
Server 5.0/Uninstall. 

 

Note: Do not attempt to uninstall Optimal Trace™ Server by discretely deleting files/folders 
as this could create problems for you later.  
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9 Running Optimal Trace™ Server 

This section describes how you may run Optimal Trace™ Server. For instructions regarding 
licensing and upgrading Optimal Trace™ Server see Section 10 Licensing Optimal Trace™ 
Server. 

 

9.1 Starting Optimal Trace™ Server 

To run Optimal Trace™ Server from Windows move through: Start/Programs/Compuware/ 
Optimal Trace Server 5.0/ Optimal Trace Server. 

A splash screen will appear, Optimal Trace™ Server will load, and the screen shown below will 
appear. 

 

Note: If you did not use the default locations when you installed the Optimal Trace™ Server 
application, then move to the directory where the software is installed and click on the 
Optimal Trace Server.exe icon in the 'Optimal Trace Server' subfolder. 

 

1. Enter the Username and Password in the text boxes provided. 

 

2. Choose ‘MySQL’, 'Oracle' or 'SQLSERVER' from the database dropdown menu, as 
Optimal Trace™ Server needs to know what kind of database it's connecting to. Note: 
with Oracle, if you did not create a new 'Catalyze' database, replace the 'Database 
Name' value below with the name of your Oracle database. 
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3. To start the Optimal Trace™ Server, simply click on the ‘Start’ button and Optimal 
Trace™ Server then starts running.  

 
4. Once the server is started, the final step is to check that the Optimal Trace™ 

Enterprise Client can connect to and use the Optimal Trace™ Server ok. To do this, run 
Optimal Trace™ Enterprise Client, and select the 'Tools/General Options' menu option 
and then select the 'Server Settings' tab. Enter the host name where your Optimal 
Trace™ Server is installed, accept the default 'port' and 'polling interval' settings and 
hit 'Save'. Finally, create a new Optimal Trace™ Project (make sure you select 'Create 
a new remote project in the repository'), add some data and save. There will be no 
error messages if everything is installed and configured correctly. If there are 
problems, check the connection by hitting 'Test Connection...' and sending the results 
to your network administrator. If problems persist, contact the Optimal Trace™ 
Support Team; see section 1.2 Contacting Optimal Trace™ Customer Support for 
contact details. 
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9.1.1 Stopping the Optimal Trace™ Server 

To stop the Optimal Trace™ Server, simply click on the ‘Stop’ button. This will kill all server 
processes started by the Optimal Trace™ Server. 

 

9.1.2 Configuring the Optimal Trace™ Server as a windows service 

Optimal Trace™ Server is automatically registered as a Windows service during installation. 
Before starting the service you must run through the steps in section 9.1 Starting Optimal 
Trace™ Server to ensure that the server can be started with the specified options. To use the 
Optimal Trace™ Server service do the following:  

2. Before starting the service ensure that Optimal Trace™ Server is not already running. 

3. To start/stop the service from the Microsoft Management Console:  
Go to Start/Settings/Control Panel/Administrative Tools/Services; and  
right click on 'Optimal Trace Server 5.0' and choose Start/Stop. 

 

9.1.3 Stopping the Optimal Trace™ windows service 

Open Control Panel and launch 'Administrative Tools' -> 'Services' 

navigate to ' Optimal Trace Server 5.0': 
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right click, and select 'Properties': 

 

 

'Stop' the service (if its running) 

Change the 'Startup type' to 'Manual'. 
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9.2 Optimal Trace™ Email Configuration 

The Optimal Trace™ Email Settings are used to configure access to an SMTP server. Optimal 
Trace™ notification emails are sent to registered users by the Optimal Trace™ Server using 
the SMTP server/details you provide. Your mail server administrator should ensure that the 
Optimal Trace™ Email Settings that you use will allow sending mail to all of your Optimal 
Trace™ users' email addresses. It is best to discuss the Email Settings that Optimal Trace™ 
Server uses with your company email Administrator. It is best practice to create a dedicated 
email account for use by Optimal Trace™ Server.  

See the Optimal Trace™ Enterprise Help for more information on the Notifications feature. 

Your email administrator needs to provide you with: 

- the name of your companies mail server ('SMTP server' setting below) 

- the email user name that Optimal Trace™ Server will use ('Username') 

- the password for the Optimal Trace™ Server user name ('Password') 

- whether or not the email server requires a Secure Connection (SSL). 

 

 

hen you have finished entering the email configuration, you can test that it's working by 
e 

me spam filters may block this message, so you will need to work through 

s: 

widgetcodomain.widgetco.com 

 

W
clicking on the 'Test Email Settings' button (and enter your own email address to receive th
test message). 

Note also that so
this process with your email Administrator. 

Sample values would be something as follow

SMTP Server: WidgetCoSMTPMailServer 

Username: <Optimal Trace server user>@
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Password: <password> 

The test email that you receive will simply contain 'Optimal Trace Email Settings Test' in the 

r 

n (RFC 2554 - 
. 

.2.1 Example Email Configuration using GMail 

subject line. If you do not receive a mail, you may need to check your email servers spam 
filter as the message may have been blocked (e.g. if you do not specify a domain in your use
name, some spam filters may block the message). 

Note: Optimal Trace™ supports SMTP authenticatio
http://www.ietf.org/rfc/rfc2554.txt) mechanisms LOGIN and PLAIN

 

9

At the time of writing, Google's GMail can be configured to be used by Optimal Trace™ Server 

il account 

m 

d> 

ption> 

.3 Optimal Trace™ Server Advanced Configuration 

as the mail notifier. This can be useful if you are evaluating Optimal Trace™ Server and don't 
want to set up a dedicated Optimal Trace™ user on your company's email system.  

Enter the following settings if you want Optimal Trace™ Server to use your GMail ma
to send notifications from: 

SMTP Server: smtp.gmail.co

Username: <you>@gmail.com 

Password: <your gmail passwor

Use Secure Connection: <tick this o

 

 

 

9
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The Advanced tab contains default parameters. Change them, if you wish to enhance the 
performance of Optimal Trace™ Server. 

 

 

 

Configuration Description 

Server Monitor 
Interval 

Optimal Trace™ Server maintains a ‘keep alive’ connection between it and all 
its Optimal Trace™ clients, so it can monitor these client processes to ensure 
that the connection between them is valid. The interval specified here is the 
number of seconds between each ‘keep alive’ message. This 'keep alive' is a 
'ping' that is sent from the Optimal Trace™ clients to the Optimal Trace™ 
Server. This interval specifies how often this 'ping' should be sent, specified in 
seconds. 

Server Listener 
Port 

This is the TCP/IP port that Optimal Trace™ Server runs on. If you are running 
a firewall on your machine, you must ensure that this port is left open for 
inbound connections to Optimal Trace™ Server. 

Server 
Disconnect 
Attempts 

The Optimal Trace™ Server will disconnect any Optimal Trace™ clients that 
have not 'pinged' it, after this specified number of attempts. As part of this 
disconnect process, all locks held by the client will be released and other 
clients will be free to work on the Projects that may have been locked by the 
'dead' client.  

By default, if Optimal Trace™ Server does not get any pings from a client after 
5 minutes (60 seconds * 5 attempts) the client will be disconnected and any 
locks on any projects it may have held will be released.  
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10 Licensing Optimal Trace™ Server 

This section describes how you license and upgrade the Optimal Trace™ Server application. 

 

10.1 Evaluating Optimal Trace™ 

Optimal Trace™ can be evaluated for a specific period of time without a license key. When 
you first run Optimal Trace™ Server you do not require a license. 

The evaluation period is calculated from the time of first usage, in other words from the initial 
running of Optimal Trace™ Server 

Once this period of time elapses, you must either purchase a full license or else apply for an 
extension key. See section 1.2 Contacting Optimal Trace™ Customer Support for more details 
on how to contact Compuware support. 

 

10.2 Licensing the application fully or using an extended evaluation license key 

Aside from the initial evaluation period as outlined in the previous section, Optimal Trace™ 
Enterprise requires a license to run. Optimal Trace™ Server ships with a License 
Administration utility called the LAU (License Administration Utility). For full details on how to 
license Optimal Trace™, please run the LAU and refer to the LAU help file under the 'Help >> 
Index...' menu option. 
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